LENESANS Release Note

RZ/T2M Group
Encoder I/F FA-CODER sample program

Summary

This document describes the RZ/T2M Encoder I/F FA-CODER® sample program package. To use this
sample program, please obtain the “RZ/T2M Group Encoder I/F Configuration Library” release package
(Rev.1.60 or later).

For FA-CODER® communication protocol specifications and encoder specifications, contact Tamagawa
Seiki Co., Ltd.

Functionality Checked Device
RZ/T2M CPU Board (RTK9RZT2MOCO00000BE)
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FA-CODER is a registered trademark of Tamagawa Seiki Co., Ltd.
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RZ/T2M Group

Encoder I/F FA-CODER sample program

1. Package Contents

This package contains the following contents.

The Configuration Data included in this package supports up to 2 axes, but the sample program supports

only 1 axis; to use if with 2 axes, modify the sample program to support 2 axes.

1.1 Software

e Source

code

No.

name

version number

1

RZ/T2M FA-CODER sample progra

m

1.3

e Configuration data

No. name version number
1 RZ/T2M Encoder I/F Configuration Data (FA-CODER) 1.1
2 RZ/T2M Encoder I/F PINMUX Data 1.0
1.2 Document
No. Document name Version File name
1 RZ/T2M Group Encoder I/F FA- 1.60 (j) r11an0587jj0160-rzt2m.pdf
CODER Sample Program Release (e) r11an0587¢€j0160-rzt2m.pdf (this document)
Note
2 RZ/T2M Group FA-CODER Sample | 1.30 (j) r11an0584ij0130-rzt2m-fa-coder.pdf
Program Application Note (e) r11an0584ej0130-rzt2m-fa-coder.pdf
3 RZ/T2M Group FA-CODER 1.40 (j) r01an6315jj0140-rzt2m-fa-coder.pdf
Interface (FAC) Application Note (e) r01an6315ej0140-rzt2m-fa-coder.pdf
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RZ/T2M Group Encoder I/F FA-CODER sample program

2. File Structure

The file structure and contents of this package are detailed below.
Top
F— r11an0587jj0160-rzt2m.pdf
— r11an0587¢j0160-rzt2m.pdf
L— workspace
— Software
| — iccarm
| | L— RZ_T2 fac.zip : RZ/T2M FA-CODER sample program set (IAR)
| —gcc
| L— RZ_T2_fac.zip : RZ/T2M FA-CODER sample program set (e2 studio)
L— Documents
F— r11an0584jj0130-rzt2m-fa-coder.pdf
F— r11an0584ej0130-rzt2m-fa-coder.pdf
— r01an6315jj0140-rzt2m-fa-coder.pdf
L— r01an6315ej0140-rzt2m-fa-coder.pdf

The file structure of the RZ_T2_fac.zip is shown below.

Top folder
I configuration.xml : FSP Configuration data
— R9A07G075M28GBG.pincfg : RZ/T2M Pin Configuration data
— ( Environment File Depending on Build Tool )
F— lib
| L— ecl
| — Config_Fa_Coder_v1.1.dat :RZ/T2M FA-CODER Configuration data
| L— RZT2_pinmux_v1.0.bin : RZ/T2M Encoder I/F Pin Configuration data
L— src
— hal_entry.c : FA-CODER sample program
— fac_main.c : FA-CODER sample program
— enc_dat.asm : Encoder I/F Linker setup file ( only e? studio )
— siochar.c : SCI_UART sample program
— siorw.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L— drv
L— fac
— iodefine_fac.h : FAC register definition file
F— r_fac_rzt2.c : FAC driver file
F— r_fac_rzt2_config.h : FAC driver file
F— r_fac_rzt2_dat.h : FAC driver file
L— r_fac_rzt2_if.h : FAC driver file
R11AN0587EJ0160 Rev.1.60 Page 3 of 10
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Encoder I/F FA-CODER sample program

3. About FA-CODER Sample Program

This section contains information necessary to use the complete set of FA-CODER sample programs.

3.1 Software Information
3.1.1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program, FA-CODER driver, and configuration data is shown in following
table. This table does not include memory size used by Encoder I/F Configuration Library, Flexible Software
Package, or C language libraries of the compiler.

ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
FA-CODER driver Code 20 1.6
Data (with initial value) 0.0 0.0
Data (without initial value) 0.1 0.1
Constant Data 0.0 0.1
FA-CODER configuration data Constant Data 12.1 12.1
Sample program Code 4.4 5.0
Data (with initial value) 0.0 0.0
Data (without initial value) 0.5 0.6
Constant Data 2.2 2.3
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RZ/T2M Group

Encoder I/F FA-CODER sample program

3.2 Hardware Information
3.21
RZ/T2M

Device

3.2.2 Target board
(1) Board name

RZ/T2M CPU Board (RTK9RZT2MOCO00000BE)

(2) Setting of CPU Board
The target board configuration is as follows.
SW4-1: ON

SW4-2: OFF

SW4-3: ON

SW4-4: ON

SW4-5: OFF

SW6-1: OFF

(3) Terminal
The correspondence between the pin used as the encoder I/F and the pin header of the target board is as
follows.
channel Port name Pin header Input/Output Description

(Function
pin name)

FACODERO SRQO CN1 #3 output Request output pin
(ENCIF2)
DEO CN1#4 output Represents request output when DEO = 1
(ENCIF3) Represents input data reception when DEO = 0
SDATO CN1 #1 input Input data reception pin
(ENCIFO)

FACODER1 SRQ1 CN1 #9 output Request output pin
(ENCIF7)
DE1 CN1 #11 output Represents request output when DE1 = 1
(ENCIF8) Represents input data reception when DE1 =0
SDAT1 CN1 #7 input Input data reception pin
(ENCIF5)
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RZ/T2M Group

Encoder I/F FA-CODER sample program

3.3 Procedures on Development Environments

3.3.1 Preparation before Executing the Sample Program
This sample program communicates with a PC. The USB connection terminal on the target board is CN16.

The terminal software of the host PC is set as shown in the following table.

function setting
Communication method Asynchronous Serial transmit/receive
send / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM v9.32.2
RENESAS RZ/T2 Flexible Software Package v1.3.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs

The build procedure for the sample program is as follows.

1 Copy the extracted source files to the desired location.
2 Copy the following files from "RZ/T2M Group Encoder I/F Configuration Library" under lib\ecl in the
same folder as the source files. (If the "lib\ecl" folder already exists, overwrite it.) *1

e lib\ecl\r_ecl _rzt2 iar.a
e lib\ecl\r_ecl rzt2_if.h

Activate EWARM.

o o~ W

Select [File] menu -> [Open Workspace].
Open the extracted source file RZ_T2_fac.eww.
Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *2

Note: 1. Please use Encoder I/F Configuration Library revision 1.50 or later (release package revision 1.60
or later) that corresponds to the EWARM v9.32.2.
2. The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of
the EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text RZ Smart Configurator
command $RASC_EXE_PATHS$
argument --compiler IAR configuration.xml

Initial directory

$PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file,

rasc.exe.

You can also start the FSP Smart Configurator directly from the command prompt by specifying

the folder where it is installed.

R11AN0587EJ0160 Rev.1.60
Sep.29.23
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RZ/T2M Group Encoder I/F FA-CODER sample program

7 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

!E C:¥1_Prog¥Work¥Work_C¥Work_EWA_932_2¥RZT2M_FAC release_chk - FSP Smart Configurater - O X ‘
File Window Help Run

[RZT2M_FAC _release_chk] FSP Configuration FSP Visualization =8

] S b
Summary Generate Project Content i
j ~

Project Summary e,

Board: RSK+RZT2M (RAM execution without flash memory) =

Device: RIADTGO75M28GBG =

FSP Version: 130 it B

Project Type: Flat - L

Location: C:M1_Prog/Work/Work_C/Work_EWA_932_2/RZT2M_FAC_release_chk = +-

Selected software its -

Arm CMSIS Version 5 - Core (R) v5.7.0+renesas.1 v -

Board Support Package Common Files v13.0 = % SO -

Event Link Controller v13.0 v = = &8
510 R
Summary | BSP| Clocks| Pins Interrupts Event Links Stacks Components » iP

Properties (%! Problems Lk = 0 B Console sy m s el =
Property Value No consoles to display at this time.

8 When project generation is complete, close the Smart Configurator.
9 Select [Rebuild All] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2_fac.out is generated.

(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Execute].
2 Select [Debug] menu -> [Execute].

(5) Execution result of the sample program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2M Group FA-CODER Sample Program Application Note.

T COM4 - Tera Term VT - m} X
TrHF)  RE(E) (S IWRO-JUO)  P4VF2W)  MILTTH)
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3.3.3 e?studio from RENESAS
(1) Build Environment
RENESAS e? studio 2023-07
GNU ARM Embedded Toolchain 12.2.1.arm-12-24
RENESAS RZ/T2 Flexible Software Package v1.3.0
(2) Execution Environment ICE
SEGGER J-Link
(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Copy the expanded source file to any location.

2 Copy the following files in the "RZ/T2M Group Encoder I/F Configuration Library" to lib\ecl in the same
folder as the source file. (If the lib\ecl folder already exists, overwrite it.) *1
e lib\ecl\r_ecl_rzt2 gcc.a
e lib\ecl\r_ecl rzt2_if.h

3 After launching e? studio and moving to the workspace, click the [File] menu ->[Import] and select
Existing project to workspace and click [Next].

4 On the project import screen, select the folder where the sample program was expanded as the root
directory.

5 Select a project, check Copy Project to Workspace, and click [Finish].

6 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

& RZT2M_FAC release_chk - €2 studio — O X ‘
File Edit Source Refactor MNavigate Search Project RenesasViews Run Window Help

SR o v~ Q | R
{1 Project Explorer SEl = 0 o= Outline X =0 a

There is no active editor that &
v 5 RZ_T2 fac [D provides an outline.
s Includes
B sre
Lk,

| 2% configuration.xmi I
) pincig

RZ_T2_fac Debug_Flatjlink
X| RZ_T2_fac Debug_Flatlaunch
*| Problems % | 2 Conscle [ Properties @ 23-F-759%- [} 23-F-92a7 0 e
0 errors, 10 warnings, 0 others

Description Resource Path Location Type

% Warnings (10 items)

configurationxml - RZ_T2_fac

Note 1. Please use Encoder I/F Configuration Library revision 1.50 or later (release package revision 1.60
or later) that corresponds to the GNU ARM Embedded Toolchain 12.2.1.
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7 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzt, rzt_cfg, rzt_gen, script and .settings folders are generated.

@ RIT2M_FAC release_chk - RZ_T2_fac/configuration.xml - € studic — ] x ‘
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
% v & - 5~ Qv - A crces
Project Explorer =0 [RZ_T2 fac] FSP Configuration X nlalen 0+ Outline X =B
Thee e ediorthet
Summary e There is no active editor that
~ &5 RZ. T2 fac Generate Project Content provides an outline.
&l Includes -
- Project Summary ~

RENESAS
lib

i% configuration.xmi
R9A07GO75M28GBG.pincig

RZ T2,

Board: RSK+RZT2M (RAM execution without flash memory)
Device:  RIADTGO75M28GBG

ac Debug_Flatjlink Toolchain: ¢ for Renesas RZ

X RZ_T2 fac Debug_Flatlaunch

Toolchain
Version: 12.2.1.am-12-24

FSP
Version:
Project
Type:
Location: C:/1_Prog/Work/Work_C/Work_E2S_RZ . 0/RZT2M_FAC_release_chk/RZ_T2 ¥

< >

CEO

Summary| BSP| Clocks | Pins | Interrupts | Event Links | Stacks | Components

130

Flat

¢! Problems % | B Console [T Properties| @ 27-+-759%- L) A9-+-9=a7h =0
0 errors, 10 warnings, 92 others
Description Resource Path Location Type

% Wamings (10 items)

1 Infos (92 items)

8 Select [Project] menu -> [Build All].
The file Debug\RZ_T2_fac.elf is generated.

(4) Execution procedure of the sample program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution result of the sample program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2M Group FA-CODER Sample Program Application Note.

W COM4 - Tera Term VT - m] =
Tr{ R EEE) (S IvFO-IO)  24VEIW)  ALTH)
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Encoder I/F FA-CODER sample program

Revision History

Description
Rev. Date Page Summary
1.00 Apr.08.22 - First Edition issued
1.01 May 25.22 2,3,10 Changed file names. Corrected download destination of the
sample program.
1.10 Jun 28.22 2,3,5-10 | File name change. Changes due to update to FSP V1.0.0.
Corrected the return value of R_FAC_GetVersion to "1.0"
1.20 Aug 26.22 2,3 Update Configuration Data to V1.1
Update of sample program due to configuration data change
Changed the return value of R_FAC_GetVersion to "1.1"
1.30 Dec 12.22 23 Changed file names.
Update of sample program
- TX register address change, TIMOT2 register added
- Fixed a bug that the encoder position information was not
initialized when reset commands were issued.
- Change the return value of R_FAC_GetVersion to "1.2"
1.40 Apr.14.23 2,3 File names are updated.
5,8 Changed environment due to update to RZ/T2 FSP v1.2.0.
Update of sample program
- Revise functions to support bit rate 5 Mbps
- Change the return value of R_FAC_GetVersion to “1.3”
1.50 May 31.23 1,4 Appended section 3.1.2 for memory size information.
2,3 Updated the release note version number.
1.60 Sep.29.23 1,6,8 Append notes for the Encoder I/F Configuration Library
revision.
1,5 Updated the target board name.
2,3 Updated the release note version number.
4 Updated memory size information.
5 Updated description of the CPU board setting. (Description for
the SW4-2 is changed. SW6-1 setting is added.)
6t09 Updated build environment for FSP v1.3.0. Figures are
replaced.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
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Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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